
 

 

 

 

 

 

Module 2 – A Bird’s Eye View of Your Pilot POS 

System 

 

 

 

Overview 

This module is designed to give you an overview of the system and processes that typically take place in a 
hospitality business and therefore help you to place into context the detailed tasks and procedures that you will 
need to learn in order to get the most out of your system. 

 

The communication and learning objectives for this module: 

This module is made up of the following main sections: 

 Terminology and Concepts of the Pilot POS System 

 Reviewing Important Routines, Controls and Business Processes 

 How Pilot POS Maximises “Front-of-House” Business 

 “Back-Office” Features and Processes 

 The Hardware Components of Your Pilot POS System 

 Reviewing Roles and Responsibilities 

 Navigating and Becoming Familiar with Your Pilot POS System. 
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Terminology and Concepts of the Pilot POS System 
 

Becoming familiar with new software can sometimes be a difficult process. Not only do you need to learn interface 
and navigation features, but you also need to become familiar with program terminology and processing routines. 
However, feel confident that with the intuitive and graphical interface of your Pilot POS System and the available 
product documentation that this learning experience will be painless and brief. Use this list of concepts and 
definitions as a reminder when you may need to confirm terminology being referred to. 

 

Concepts and 
Abbreviations 

Definitions 

Admin Cashup This cashup is used to reconcile all transactions of a specific trading period 
(recommended to be done on a daily basis). Once all the individual point-of-sale 
terminals and waiters have been cashed off, you combine the cash and reconcile it 
with the Admin Cashup process. This cashup also includes a banking analysis for the 
purposes of tracking bank deposits. 

Back Stock Back stock can be defined as pre-portioned items that are ready to be issued to front 
stock and available for sale. This category can include items used to produce recipes 
such as groceries or items such as 340 ml cans. 

Batch Purchases Batch Purchases are similar to Daily Purchases. However, they do differ with regards 
to the following:  

 Batch purchases allow you to post an invoice to a period up to 60 days prior to 
the current date. This is handy for allocating certain expenses back to a different 
month for proper Income Statement reporting.    

 Batch purchases do NOT update your stock levels. This is due to the fact that the 
stock on the invoice may already be sold. 

Bulk Sheet The Bulk Sheet is used to control items that need to be portioned into items that can 
be sold separately. When the bulk sheet is used, portioning information is 
automatically transferred to the Prep sheet. The Bulk Sheet usually contains meat 
items and allows you to monitor various aspects of bulk stock items, such as stock 
levels, yield information, portion sizes and quality of product. You can also use this 
sheet to monitor the portioning capability of managers or whoever is portioning the 
bulk item. 

Bulk Stock Bulk stock can be defined as any item which is received in a bulk unit and which then 
needs to be portioned for use, for example heads of rump. You receive this item in 
kilograms, but need to portion this item into selling portions. 

Bulk Variance Bulk Variance refers to losses that may have occurred in your bulk and / or back stock 
items. The Pilot POS system generates a report by comparing actual stock quantities 
on hand to theoretical stock quantities on hand. The Bulk Variance report helps you 
determine whether you have a stock theft problem in these areas. 

Category Setup Category setup refers to the set up of categories used to group like or similar items in 
the Master File for the purposes of defining both Food Cost (Cost of Sales) groups, as 
well as Expense categories. These defined categories appear on the Income 
Statement. 

Controls The Pilot POS system uses the concept of Controls to describe and manage routines 
and business processes that take place on a daily, weekly and monthly basis. All 
control processes have a two-fold effect. The first is the actual production of useful 
information for management information, and the second is instilling and contributing 
to a disciplined environment of control. 

Daily Orders Daily Orders are used to place an order with a supplier for daily order items. Daily 
orders are drawn from two control sheets, the Prep Sheet and the Fruit and Veg 
sheet. 

Daily Purchases Daily Purchases need to be done to ensure that the system stock levels are correct 
and effective. When stock is purchased on a daily basis, the Pilot POS system 
automatically updates the relevant stock levels such as Bulk stock, Back stock and 
Front stock. 
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Day End Routine The Day End routine closes off the system for the day, storing all the information 
captured for that day and gets the system ready for the next day. This routine must be 
carried out every day, and no information must be captured for the next day before 
this is done. You should also ensure that all the daily routines that need to be 
completed are finished before continuing. 

Drystocks Sheet The Drystocks sheet is used to control food-cost problem items that are not currently 
on any of your other daily control sheets. The purpose of the Drystocks sheet is 
simply to keep track of issues for these items. 

Fills When using the Prep Sheet, actual stock that has been issued and prepped for the 
day needs to be entered in the Fill column. 

Front Stock Front stock can be defined as items that are available for immediate use in the kitchen 
or bar. These items are generally controlled on your Prep sheet, or Dry Stock sheet or 
Fruit & Veg sheet located in the top toolbar of the Pilot Admin system.  

Fruit and Veg Sheet This sheet is mainly used to monitor the usage of the fruit and veg. It can also be used 
to place your daily orders. 

Future Purchases Future purchases are the same as daily purchases. However, you are only able to 
capture “Expense Items” and not Food Cost Items. In other words, Rent, Salaries and 
so on. 

Income Statement The Income Statement is possibly the most important report that you can draw from 
the system. It contains, at a summary level, information on all aspects of your 
business. These features include: nett sales, cost of sales, gross profits, total 
expenses and nett profits. It is vital to ensure that all information and business 
process that contribute to this report are captured correctly. 

Master File Processes The Master File contains all your stock items and expense items. The information of 
any item that you purchase needs to reside in this file, as well as any item that you 
prepare or manufacture on-site. 

You will also need to add raw material items that you want to cost into this file. The 
Pilot POS system treats this file as the central starting point of the system and any file 
maintenance needs to start here. 

Order Status The Order Status report is used to check up on what stock has been received from 
your suppliers. You can use this report to ensure that suppliers are not short 
delivering or delivering erratically. 

PLU Price of Listed Unit 

The PLU Items file contains all the information about items that you sell to your 
customers. Information from this file is reflected in sales reports as well as on 
customer bills so it is recommended that a specific standard of data entry is kept 
throughout the file.  

PLU Costings PLU Costing handles the costing of PLU items. These costings includes all the stock 
items (raw material items) used in producing the PLU item, and is essentially the list of 
ingredients or recipe for this item. This allows for cost price fluctuations of the PLU 
item when the prices of the raw material items fluctuate. 

Prep Sheet The Prep Sheet forms the basis of your daily stock control and contains information 
on all the stock movements of stock items allocated to this sheet. It provides you with 
valuable information such as back stock levels, opening front stock levels, issues / 
portioning, closing front stock levels, stock usage and stock reconciliation. 

Prep Variance The Prep Variance report accumulates daily variance information from your prep 
sheet and will report on these variances for a selected period. This report is useful for 
identifying and tracking daily losses. 

Purchase Reports Purchase Reporting is an important part of any week and month-end routine. The 
system allows for various reports to be extracted using a number of selection criteria, 
like suppliers name, invoice number, payment methods and so on. 

Raw Material Costings Raw Material costings is the actual recipe of and item on the Master file. This is used 
in conjunction with PLU Costings. 
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Raw Material Usage The Raw Materials Usage report allows you to compare actual stock usage (based on 
physical stock counts) and a calculated or theoretical stock usage. This calculated or 
theoretical stock usage is determined by the costing (recipe) x the quantity of the item 
sold for the period. 

This is a very handy food cost control report as it allows you to compare what should 
have been used in the preparation of the menu (PLU) items against the actual usage 
of the item based on physical stock takes. 

Splitting Bills The Touch system allows you to manage split or separate bills for any table. You can 
have as many splits per table as required, all with different items on them. This makes 
it easier when billing a customer who wants to pay separately. 

Turnover Listing The Turnover Listing report shows you the daily sales of the business. It also shows 
important information such as how many transactions were rung up for the day, how 
many customers were served, daily discount figures and what VAT was collected for 
the day. 

Weekly Orders Weekly Orders are used to estimate placement of orders with suppliers and are based 
on the stock on hand. It requires that you have setup the re-order levels in the Master 
File. The Weekly Orders report can only be created once all stock levels have been 
entered into the stock file and a stock update has been run. 

 

 

Think and Do! 
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Reviewing Important Routines, Controls and Business Processes 
Information and best-practice business process flows related to your Pilot POS System are relatively 
uncomplicated and can be categorised into the following four “processes”.  

 
 

Daily Routines 

 

 Daily Stock 

Controls  

 

 Weekly 

Routines 

 

 Monthly 

Routines 

 

 

 

Admin System 
 

Purchases Daily Controls 
 

Income Statement 
(Foodcost) 

 

Daily 

 

 

Batch 

Prep Sheet 

Bulk Sheet 

F / Veg Sheet 

Dry Stock Sheet 

 

 

 

 

Think and Do! 
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How Pilot POS Maximises “Front-of-House” Business 
The Pilot POS System is ideal for both franchise and independent operations and provides a management 
system that allows you to concentrate on providing great service to your customers. Become familiar with the 
following features and “processes” that your Pilot POS System can offer you so that you can maximise the 
functionality of the system and enable your staff and management to focus on your customers:  

 Pilot POS has a 
customisable and 
intuitive screen 
flow.  

 The touch-screen 
layout prompts 
staff through the 
entire ordering 
process – there is 
therefore no need 
for high level 
computer literacy. 

 

 

 

 Information prompts per item are available to staff to ensure that appropriate menu items are ordered. 

 The Pilot Table Management or Host system provides an electronic floor plan of your establishment. At a 
glance you can see the status of your tables, alert waiters if a customer needs attention, assign groups to 
tables and do table bookings. 

 Tables can be found quickly through either a colour-coded layout or table numbering system 

 Graphical interfaces make table management quick and easy. Transferring tables or items between waiters is 
uncomplicated. 

 Fast Tender buttons are available to speed up transactions in a Bar / Take Away environment. 

 Fast and secure voiding functionality. 

 Full ingredient control matrix for Pizza outlets, and completely integrated delivery module. 

 

 

How Pilot POS Helps to Manage “Front-of-House” 

Business 

Note how many features and processes are available to your 
business to help you enhance the experience of your 
customers: 

 Reserve tables electronically – no more reservation 
books. 

 Waiters and managers log on with a fingerprint reader 
or a magnetic card, giving you flexibility and 
unparalleled security. 
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 Each station can be individually configured to 
optimise billing. 

 Low stock and no stock warnings on menu 
items can save you time and prevents 
disappointed customers. 

 User defined day and time availability for 
specials. 

 Automated "Happy Hour" function allows for 
easy promotional management. 

 Extensive sales performance reports are 
readily at hand, so you can monitor waiter 
performance. This allows you to manage and 
motivate staff to ensure sales and profitability. 

 Pilot POS accommodates easy bill splitting or 
merging through a drag-and-drop interface. No 
more calculators, inaccuracies and customer 
embarrassment. 

 

 

 Multiple destination order printing with re-routing capabilities ensures the order is received in the relevant 
area and never lost. 

 Pilot POS allows for multiple payment types. 

 Unique waiter cash-up: fast, easy and accurate. 

 Decimal and p / kg quantity items handled with ease. 

 

 

Reporting Functions to Maximise Business and Sales Information 

 Detailed invoice history. 

 Revenue report pre-lists give you a complete analysis of payment types. 

 Real-time sales reports keep you up to date on the financial status of your business. 
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“Back-Office” Features and Processes 
More than ever before, you need to keep control of profits, stock and suppliers. Take note of how additional add-
on modules and the powerful back office features of Pilot POS can be an indispensable tool for keeping tight 
control of your resources fundamental to ensuring that you maintain healthy profit margins:  

Easily Accessible Information 

Enhances Knowledge and Aids 

Decision Making 

 Daily and weekly stock counts with 
variance reports based on actual 
stock usage 

 Menu costing module includes 
gross profit reporting and targeted 
recommended retail pricing 

 Bulk portioning with yield analysis, 
allowing you to accurately control 
portion consistency and minimise 
shrinkage 

 Material usage reports – all recipes 
can be keyed in to work out material 
usage 

 Extensive goods receivable reports 

 Input and output VAT reports 

 A theoretical cost of sales report 
facilitating planning and budgeting 

 

 

 

 

 Re-ordering to par-
levels generated with 
price checking 

 Actual cost of sales 
report, including 
budgetary control. This 
is expandable to a 
complete Profit & Loss 
statement 

 Multi revenue centre 
sales reporting 

 Easy to use Weekly 
Order generation 
report 

 Orders can be either 
faxed or e-mailed to 
suppliers 

 Stock order and 
delivery status 
reporting 

 Accounts payable 
reporting. 
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 Customisable cash-up 
with banking analysis 

 Cost of sale reports 
per cost centre or 
consolidated 

 Extensive product 
sales reporting 

 Sales and turnover 
comparative reporting 

 Extensive waitron 
sales and incentive 
reporting 

 Detailed suppliers 
listing 

 Daily cash and banking 
control reports. 

 

 

 

 

Kitchen Display System Enhances 

Communication 

The Kitchen Display System facilitates 
better communication of food orders, 
cutting down on paperwork or vocal 
communication and speeding up food 
delivery. 
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Debtors Module Helps to Limit Liabilities  

The Pilot POS Debtors module provides for an unlimited number of debtors (with preset credit limits), journal 
entries, and statements with age analysis.  

Even if accounts aren't your strong point, Pilot POS’s user-friendly entry procedures and processes make it 
easier than ever before. 

 

 

Delivery Module Facilitates “World 

Class Service” 

Your customers know your business, but do 
you know your customers and what they are 
expecting?  

Our delivery module allows for fast lookup of 
your client base when they place a delivery 
order, and can be used to track the order until 
it is collected or delivered. 

A database with order history reporting is an 
extremely valuable asset that allows you to 
identify your customer’s needs and market 
your business effectively. This information can 
be further used to follow trends and eating 
habits to allow for better operational planning.  

By increasing your knowledge of your 
customers, and maintaining contact with them, 
you ensure you are ahead of their needs. 

 

 

 

Integration Options to Increase Service 

 Pilot Rewards in conjunction with Maxiclub 
is a provider of a full-service customer 
loyalty programme that can be easily and 
efficiently implemented. 

  

 

Flexible Transaction Management to Maximise Sales and Service 

 Barcode reading and printing capability. Effortlessly handles a hybrid hospitality / retail operation. 

 Pilot POS accommodates multiple operating modes, such as Delivery, Express Take-Out and Sit Down or 
Bar. 
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Additional Programs and Add-On Modules to Enhance Business 
Pilot Software has a range of additional programs and add-on applications that can be used to enhance more 
complex and challenging aspects of your business. 

ROSS (Remote Office Site System) 

This is an ideal enterprise wide solution for 
multiple outlet operations, as it allows for daily 
uploads of selected information to a central 
reporting head office. No more faxing of daily or 
weekly reports! Head office receives extensive 
reporting and comparative graphics to facilitate 
financial control and make sales analysis quick 
and easy. Menu or price changes can be 
executed remotely at the press of a button. 

ROSS provides an extremely secure method to 
'lock down' stores, ensuring all data and other 
intellectual property are standardised throughout 
regions. Flexibility is still retained to a large 
degree at a store level, ensuring that Pilot POS 
and Administration is as effective for the individual 
store operator. 

 

 

 

PPIM (Pilot Pastel Interface Manager) 

Pilot Pastel Interface Manager (PPIM) allows for 
automated transfer of financial, inventory and sales 
information from Pilot POS to Pastel Accounting, at 
either a store, head office or bookkeeper level. PPIM 
delivers detailed information to Pastel, per financial 
period, including: 

 Sales - consolidated daily, with VAT split 

 Purchases - split between stock and expenses, 
with corresponding line item, creditor control or 
bank control detail 

 Usage (direct costs) - Split per category  

 

 

By using PPIM, bookkeepers are no longer required to: 

 Duplicate GRN (purchase invoice) and expense information within Pastel 

 Maintain GRN line item detail 

 Maintain usage detail by category and product. 

 

Using the Pilot SMS Module to Modernise Operations 

Pilot Software have developed an SMS module, which offers the 
following features and benefits: 

 SMS Bookings  

 SMS confirmation can be sent to clients with Date, Time, 
Name, Cell, and number of guests.  

 If clients respond to your SMS, you can retrieve replies as 
well! 

 You can automatically SMS promotions to your Bookings 
database, or your Delivery database. 

 SMS templates can be saved and messages can be 
personalised with client information. 

 Note  ADSL or another permanent internet connection is 

 required for immediate sending. 
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Web Support... 

Log into Pilot's systems via the internet. Open a 
support call, check on the status of repairs, or view 
your account statement. 

Absolutely FREE, and only from Pilot. 

 

 

 

The Hardware Components of Your Pilot POS System  
Your Pilot POS system is made up of a number of hardware and software components. It is important to 
understand the elements, features and benefits that are applicable to your particular working environment so that 
you know who to delegate problems and escalate issues to. 

 

Typical hardware components 

of a Pilot POS System 

 

 

 

 

 

 Work 
Stations 

 Back office 
PC’s 

 Monitors 

 Swipe Card 
Reader 

 Barcode 
scanner 

 Barcode 
label printer 

 Touch 
Screens 

 Pole displays 

 Bill Printer – 
Thermal printer 

 Order Printer – 
Dot Matrix 
printer 

 Modem 

 Uninterrupted 
Power Supply 

 Cash Drawer 
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Reviewing Roles and Responsibilities 
Review the Pilot POS system information that has been presented and discussed so far. When the Pilot POS 
system is installed at your business it is possible that there will be a range of different user levels required, which 
in turn means different roles and responsibilities around the system. Use the discussion activity to explore 
concepts of user access and responsibilities of different staff members who will engage with the system. 

 

 

Think and Do! 

 
 

Extra Notes 
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Navigating and Becoming Familiar with Your Pilot POS System 
Getting used to navigating and moving through your Pilot POS System is easy. The terminology, buttons and tabs 
of the program have a simple visual interface and are designed to be intuitive. Once you begin to recognise 
buttons, tools and terminology, you will be able to open the screens you want to work on with a couple of mouse 
clicks or keyboard strokes. The following sections introduce the basic elements and concepts of the Pilot POS 
System.  

Starting Your Pilot POS System 
Once your Pilot POS System has been set up and all system defaults have been put in place for your business, 
there are programs, functions and tools that you will need to become familiar with. 

Use the following procedure to start Pilot POS and access the different modules: 

 

 
Starting, logging onto and using the Pilot POS Admin Program 
Use the following procedure to start Pilot POS Admin and explore and navigate the program: 

 1. From the Desktop, locate and 
click on the Pilot Admin menu 
option: 

  

2. Once you have entered your 
allocated password, or 
confirmed access using a 
finger print, the Admin 
desktop will be displayed. 

 

 

 

 

Important  Do not switch off your machine without closing or exiting all programs correctly as this can cause 

document and database corruptions that are often difficult to rectify. 
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Program Components That Make Up the Pilot POS System 
Your Pilot POS System is made up of the following elements or program components: 

 

The Admin application, or program, is the “heart and soul” of your Pilot POS System. It is this 
part of the program that helps you to manage and maintain the integrity of information 
related to your business such as: 

 Monitoring costing and control of prices of stock items listed units 

 Managing master stock files which contain information about your stock and expense 
items 

 Managing and maintaining bulk and prep sheets 

 Access and implement daily controls 

 Manage information relating to suppliers and purchases 

 Accurate stock control functions  

 Staff and waiter details and information  

 Information of clients that you normally deliver to 

 Accessing and sending mail via the Mail Manager 

 Controlling user access 

 Reports 

 System setup and configuration parameters. 

 

 

 

This program allows you to customise and maintain the Point-of-Sale interface so that you 
can create the look and feel that your business requires. 

 

 

This module of the Pilot POS System is what employees, supervisors and managers use to 
open, transact and conclude business.  
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Navigating the Pilot Admin Program 
If you have worked in a business environment where you need to login to systems or a database, understanding 
how to login to Pilot Admin will be a natural process. If you have not experienced this type of work process before, 
the procedure is intuitive and quick. 

The Pilot Admin menu options 

You can use the Admin menu options to access the functions or processes that you need to perform. Click on 
each menu option and start familiarising yourself with the tasks and functions that are available: 

 

 

The Files menu 

 

 

Use the File menu to 
maintain and manage 
the information on your 
system.  

Good information is an 
important part of 
maintaining an 
administrative system 
that can offer you 
reporting that is 
accurate and does not 
contain obsolete or 
unnecessary 
information.  

Refer to the training 
material developed for 
Site Operators (Module 
5 – Using the Admin 
System to Manage 
Information) to view the 
specific tasks and 
routines that are 
required to add, edit 
and manage the files 
on your system. 

 

The Controls menu 

 

 

 

Use the Controls menu 
option to access 
functionality and 
routines that will be 
used on a day to day 
basis.  

It is essential that these 
routines are completed 
correctly for daily 
reporting to be 
accurate. If these 
controls are used 
correctly, the system 
provides you with a 
powerful set of reports 
from which you can run 
your business.  

Refer to Module 4 – 
The Pilot POS System 
for Supervisors and 
Managers for more 
detailed information 
about working with 
Controls. 

 

The Purchases 

Menu 

 

 

The Purchases menu 
option allows you to 
use tools and records 
to track all incoming 
stock and expenses of 
your business.  

Any item that is 
purchased by your 
restaurant needs to be 
captured on a daily 
basis in order to ensure 
that the reporting 
information on your 
system is up to date 
and accurate.  

Refer to Modules 8 and 
9 for more detailed 
information. 

 

The Stock Menu 

 

 

Use this menu option to 
manage your stock on 
a daily and weekly 
basis. 

Refer to Modules 8 and 
9 for more detailed 
information. 
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The Reports Menu 

 

 

 

 

 

Reporting forms a 
vital part in the 
management of your 
restaurant. The 
Reports menu option 
offers you excellent 
information 
summaries for a wide 
range of aspects 
within your business.  

Refer to Module 10 – 
Working with Reports 
for more information. 

 

 

The Costing Menu 

 

 

 

 

 

 

The Setup Menu 

 

 

 

The Costing menu 
option provides an 
additional control tool 
for your business by 
allowing you to 
compare actual stock 
usage figures with 
theoretical stock 
usage figures. 

Refer to Modules 8 
and 9 for more 
detailed information. 

 

Use this menu option 
to manage system 
parameters.  

Important  Do not 

make changes 
without qualified Pilot 
support as changes 
may affect the way in 
which the system 
performs.  

 

The Help Menu 

 

 

 

Use the Help menu 
option for 
administrative and 
licensing processes.  

 

 

 

The Pilot POS Admin Toolbar 

The toolbar gives you quick access to the main program functionality that you are most likely to use in a normal 
working day.  

 

 

 

 

 

 

 

 

 

 

Start your 
Day End 
routines. 

Opens the Cashup 
working window. 

Start the daily 
Purchases tool. 

Use the Daily Orders 
tool to confirm what 

items need to be 
bought for the day. 

Keep track of what 
Bulk Items have been 
issued.  

Monitor what stock 
you have on hand. 

Prep Sheet. 

Integrate your 
email if 

necessary. 

Exit and close 
the Admin 
Program. 

Access the 
Touch Design 
functionality. 

Access Pilot’s Intime 
Time and 

Attendance Program 
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Navigating the Pilot Touch Design Program 
The Pilot Touch Design program allows you to design menu options and controls how the POS screen touch 
buttons are linked to their relevant departments and PLU items. When you are designing and editing touch 
buttons you must be sure of where you want to link the button to and what stock they represent. The program also 
allows you to design table layouts that can represent the layout of the restaurant on the POS Touch screens. 

 

 

Starting, logging onto and using the Pilot Touch Design Program 

Use the following procedure to start the Pilot Touch Design program: 

1. From the Desktop, 
locate and click on 
the Pilot Admin menu 
option: 

2. From the top toolbar, 
click on the Touch 
Design button. 

  

3. Enter your 
management code, or 
confirm access using 
a finger print, to start 
the program. 

The Touch Design 
screen will be 
displayed.  

 

 

 

 

 

Note  Detailed tasks and procedures for using the Touch Design program are covered in detail in Module 7 – 

Using Touch Design to Customise the Look and Feel of Your System. 
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Designing Menus 

 

4. Click on the Design 
Menus button to 
edit and add new 
items to your Pilot 
POS System. 

5. Click on the 
Screens button, 
and select the “Re-
create workfiles 
from live screen 
files menu option. 

6. Confirm that you 
want to work with 
the Live file. The 
Screen Editor and 
Touch Design 
working window 
will be displayed. 

7. Click on Exit to 
navigate and 
explore the Design 
Tables option. 

 
 

 

 

 

 

 

 

Note  Refer to Module 7 – Using Touch Design to Customise the Look and Feel of Your System for detailed tasks 

and procedures on how to use the Pilot POS Touch Design program.  

 

Design Table Views 

 

8. Click on the Design 
Table Views button 
to edit and add 
preferred table 
shapes to the Pilot 
POS System. 

9. The Screen Editor 
and Touch Design 
working window 
will be displayed. 

 

 

 

The Screen Editor is a tool which displays the screen that you 
are working on and allows you to select different screens and 
buttons for editing. It enables you to change labels for buttons 
and the links associated with the buttons. 



Module 2 – A Bird’s Eye View of Your Pilot POS System 

Page 2 – 20   Navigating and Becoming Familiar with Your Pilot POS System 

 

Designing the Floor Layout 

 

10. Click on the Design 
Floor Layout 
button to edit and 
design the layout 
of your restaurant 
floor. 

11. The Screen Editor 
and Touch Design 
working window 
will be displayed. 

 

 
 

Note  Refer to Module 7 – Using Touch Design to Customise the Look and Feel of Your System for detailed tasks 

and procedures on how to use the Pilot POS Touch Design program. 
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Navigating the Pilot Touch POS Program 
 

 

Starting, logging onto and using the Pilot Touch POS Program 

When you open the Pilot Touch POS program, the worktop gives you quick and easy access to billing and 
program options. Use the following procedure to start the Pilot Touch POS program: 

1. From the Desktop, locate and click on the Pilot SQL – POS menu option: 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The first row of Touch POS buttons allow you to perform simple functions such as drawing cash 
from the till, printing bills and viewing and working with closed and open tables cash payouts. 

 

The Manager Menu 
button gives you 
access to a 
management 
working window. 

 

 

 

The Floor 
Plan button 
gives you 
access to 
the hosting 
function. 
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Understanding the Features and Functions of the Touch POS Program 

The Pilot Touch POS program has a wide range of features and functions that can be accessed through the 
Touch program. Use the following steps to review the Touch POS functionality: 

1. From the Desktop, locate and click on the Pilot Touch Design SQL menu option: 

  

2. Click on the Manager Menu button and enter your login password. 

  

3. The POS Menu window will be displayed. 

4. Click on each button to view the functionality that Touch POS makes available. 

 

 

 

 

 

 

 

 

 

The Waiter Cashup control 
allows you to run a “pouch 
system” for staff members. 
Each staff member needs 
to reconcile money 
received against their 
sales and commission 
earned for the shift. 

Cash payouts are used to 
track cash payments 
made from a till to 
suppliers. A slip is printed 
for each cash payout and 
can be attached to the 
invoice. Cash payouts are 
included for reconciliation 
purposes. 

Use the IOU / Loan function to 
keep track of monies loaned to 
staff members. 

The POS Cashup function 
is typically used for bar 
station or cash desk type 
situations. 

The Sales (X) function displays 
an “X report which will show you 
all Station and Bill totals.  

The Stock (POS) 
function gives a quick 
display of available 
stock for a specific POS 
terminal, for example a 
bar. 

Use the Open Tables 
option to get a quick 
overview of open 
tables, which waiters 
are assigned to them 
and order details for 

If you are running 
Pastel Accounting you 
can pay into a client’s 
account from the POS 
station. 
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The Pilot Touch POS menu options 

You can use the Admin menu options to access the functions or processes that you need to perform. Click on 
each menu option and start familiarising yourself with the tasks and functions that are available: 

 

 

The File menu 

 

 

Use the File menu 
to access and 
manage information 
related to staff, PLU 
items and 
suppliers.  

You can also 
access functionality 
that manages client 
delivery information 
for you. 

 

 

The Controls menu 

 

 

 

The Controls menu 
option allows you to 
access business 
controls and 
processes so that 
you can manage 
your business from 
any Touch POS 
station. 

 

The Reports Menu 

 

 

Use the Reports 
menu option to give 
you instant access 
to important 
information about 
the transactions 
that are taking 
place in your 
business. 

 

 

The Setup Menu 

 

 

Use the Setup 
menu to set up or 
change 
workstations and 
print destinations. 

 


